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 نـقــاشــی دیـجـــیـتـال



�#$�% 
&�'( )��* � +��,# ���-# .� /!�0 

��� �����	 
��
���� ������ ����
�� �� ���� ������ ��� ����� ��� ! "��� 

 ����� ��	�
 �� 
�� ����� ��.���� ����� �� 
��� ��  !�" �� � #�$$% &�'�( ��% )* ����
 +� , +-.�� � /�01 +��
��% �*�2
 )* 3��(

 &�4 5�6�$" �� �� 7���8� ���� 9�: ;���� ;% �����$% +��<�  �$��� =���>? �� +*�� )�$@
 A�%�
 �� � B�� 3?�� , 3(��>��% , C�� ���-
 :

 !�$EF�.��(�� +*� ;?�  B� ;G�>� ;� .. � +-.�� )* �����>� 3*�H� �� , +*�� )�$�@
 � ������� ;� �� #��I>(� �� � ;���� ;% 3���� ����� �F� ;�

 +*�J*� ;� �� +��
��% � B� ;?�  ��>�G*� +��<�.��$% KL�  

  

  

  



 

 

3 

  طرح اولیه-1

��� ���  

 B���.��$% ��G*� �*�1 �$( )* �*�� M���  

 B�$� ��File >New  �� NJ. � #��% ����
 �� �$( !*�ok  B�� �� �� 9�	� �* � !O����� B #�����.��$% !��-
 �*� P@" �� K��Q� �� #����� 7��%

120 .���� ���. U$*� B�� �� NV@��  

  

.��$% +� ��G*� �� �*�1 ;*4 )*  

Layer > New ... > Layer    W�F�8$
 �*� B�$� ;� ;-1��� �� �����
 +�.��$% #��I>(� X(�>� ���� )* �� ��$% +-( , /�Y>�� �� ���� �����

 .��$% !��-
 ��� ���� B��� �� B�
 K�.�Window>brush 

�����>�� +> �� ;� ���� 3(� �� P�.��� +� N�@O
 �� �� +��<� B�$J���Y>(� , ��O@� 3(� ���. ;% +:�Q� !���� % KL� �� +L6� N*�>(� �.��$

.��O@� �� W��*�1 �����
 +� +> �� ;� /�� � A(�$� B�$J���Y>(� � N*�>(� )* !>��� �� ;% �*� ������ B�-� N ��� ��@" �� ;% ��Q��F� P

��$�J�� �*�  B #�����flow  B�� �� ��75% .�O@� �� N*�>(� ����>� C��F@�F% ;%.&� #��� ���.  
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% +*�F]�.��O% +� �*�1 B ;*4 �� 7���8� ���� 9�: �� �� +L  
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��� ���  

]��� �>O�� W��*�1 7��O% B��� 4�   3�?�I� ��>��.���� +� &�G�� ��% �� �� N�J��
� � #�$���  Opacity  B�� �� �� +L-? ;*430 %  +� ���.

 �$� �� ;@$*� &�� � ����Layer > New ... > Layer .��$@�� ��G*� +LJ. ;*4 B�� �� �*�1 B ;*4 )*  
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��0 ���  

�� NJ. ;L �� 3FV. !*� �� *�$� �*�� !���.��$% ���@
.�*����� ��1�� ���>%���% � X�_� �� +>(�� &�? � N@� �����>� ;@*��Q�$-* 5B��( 3�?�I� +

 7��O% ��Q$�F� � �*�1 ;*4 ��G*� � �*� ;*4 7�1 �� ��� B���>%���% ]W4�  ��� 3�.`� �� #��I>(� �� ��$% +-(.�
 ��F
 � �
 K�.� W��*�1

.�*���� )F% , ��8$� !*� B��� , ;���� �� �*��2
 �� �����
 +�.��$% ����F� �H�� B ;?��. �� �� 7�G�� � ��OYJ�  
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�$��1 ���  

 ��(� +� +*�1 ;� NJ. N ��� 7��� &�G�� �� P� W��*�1 ;� �>O�� � ��$% ��� �J*�<
 �� +L% W��*�1 �*�� ;% �*� P@" ��.��(�� �
 )��%

 +� �*� P@" �� � #�� NJ. B ;L �� �� �>H� ��'�� 5�( ]3��  ��Q$�F� � ��� ;>?�' +��J. N��. &�? �J*�<
 , P�L� B�H$���� &�?.��$�J�
 �����

 � 7��� � ��� 5�( W��*�1 ;% ��$�J� +> �� ;� � ����� +� 3�.`� a*�>� !*� ;� 7��(�.3(� #��% ���� �� +L6� &�? � #�� N��% 
*�HL�J(

.��% �� 3?��b +*����
 B� ;���� P�@(� !�$E$*� 7��O% � 3��( ;��4 ;% �$>V� B�-� ����� , 3�.`� �� #��I>(� B��� =���>? ����� �� 7��% ��%

.3(� ��>�G*� +��<� ��  

  

  

  

 B ;L �� B��� B�H��. �� ��% 
Y� !*�>FH�.����� ;>��� +'���� X� �'� 3V�� �H� ��% B�G$*� �
 ����� ;>��� ;1�
.�*�� +� #���� B�-�

3F � ��$% +� ��G*� ;% + �: 3��� 3(� ���. 7��.�$��� c<� 7��� �*�� �� N*�>(� ;% 3(� 7��(� #��Y�� B� ;G�>� ;� ,  9�: ��G*� ;���� 

3(� �>H� P� , ��O@� ��� �� ��% B�$� �*� � +� � 57��(��$? ;% ��$% 3.� ��>�� !�F� ��/ ��$�@� . : !��� ;% �*��$�  

2 �#        3% $��,� ��
 ��1 ��� 4/5!�� ������� ��$ 
��% $����3  

 �*��0�� 3(�� �� ��� 3O� P�☺  
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  تنظیم خطوط و اسکیس طراحی شده-2

��� ���  

�� +FH� B����% �*�� ;L �� !*� �� d� � e�Q� �*��.���� &�G�� �*� #��O% ;% + �: �� ;Q��� W��2� ��� #�� �(� � �*� #���� ��1�� ;% �� +��@�

 �*�� �� P�L� B�� !���� ��Q$�F� � ��'�� � #�$��� ���.��$% 
*��*� NJ. �� �
 K�.� �� ���>%��% N*�>(�.��$% 
*��*� B�
 K�.� ���V�� ��Q

� W��*�1 � ���� &�? N��%� �� ;% +L6� !���� ;>J��.��$@� 
*��*� �� �H�� ��@�� ;��' �� 7�*� W��6 �� � �$�@� B�
 K�.� +(��� ��� �� �H

B��� 3FV. !*� �� 
*��*� &�G�� �� NJ..����� ;>��� �8� �� �*�� �� �� 7� � �*� +� /�V  ;� 7�� +��<� +L6� �6�$" �1 �� �*��� �*�2
 � !>��

 e�Q� �� B�>H� 3�I�% �
 �� !O����� 3V� ���� +$-*.���� ���f
 �� P@" 9�	� ;% 3V� �>H�300  P@" KJ:.���� ���f
 U$*� B�� �� NV@��

.��$% NF" , ��% B ;���� B��� �*� B��.���� &�G�� �*� P@" KJ: �� �� ���� W�F�8$
Flow ����  �� ���� ����� ���� �� P@" KJ: B�� ��50% 

.�*��0��  
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 3�?�I� 7��% �% �� ���� 7�
�:�� �'� +*��>�� N ��� ��  Opacity  +� �� +��<� #����� �*�1 B�� ;*4 ��G*� Pg( � , #�� ��% B�� ;*4

*� ��.��$@� h?� �� W4�@�� �
 C��F% B�� ;*4 7�*� �� ��>V���
 +� � �*��O%! .����� &�G�� �� ��% 7�F� �*� P@" �� K��Q� �� ;L ��  

  

  



 

 

11 

P� �� ;@$*� ��% P�@(� �� &�G�� ��� �� 3*�H� ;� ;G�>� B� �*��(� ;% 3*�	� 
Y� ��� � ]���@� +6�� �� ��% �*�*�� , 7��� ���f
 3�?�I� 

;*4 �� +��F
 ;*4 �� �� ;L�(�� B ��L% Ctrl /�Y>�� +� ��$% � �� 7�� B����L% +J�%�
 Ctrl +G  �H�� �� �� )* #��' ���. +� ����.� ]��� ;*4 

�� �� B�� Multiply /�Y>�� +� ��$%. &��Outline  .��$% +� NI. +$�*�� P@" �$��� �� 7� � ��$% +� /�Y>�� ;��� B��� ��  
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 نقاشی آمیزی رنگ مراحل اولین -3

��� ��� 

B��� M��� ��% C�� B���� �� 3��( )* ;*4 �*�1 �� �*� ;��� B P�@(� �*�� N ��� �� &�G�� ����. �� �� ��% &�F
 �-� ;� 4�  �� ;% ��$% 3.�

 B ;��� �*�Outline   .����� &�G�� �� +��<� P�@(� e�Q� 7�*� �� �����>� ;% ��� +� &�G��B��� !*� ;L �� �*�� �� ����� Pen �$�� ����� .

Pen �� /�Y>�� +� ��$% � �G  !���� �� �� 3.�  ����/�Y>�� , ���� +� ���.;% �����>� 7��� 7� �� 3@]L]( #��% � C�� ��$%. 
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       ���i�� �i� ;i% +iQ� !>iV� � Ni�J��
� 5��� X� /�Y>�� �� P�Pen        ;i% 3i��  7�iF� �� �*��i% ��iG*�Pen      B�ij? �� 3i(� /�iY>�� ���i�

B ;$*�' � #��% 3(�� )�L% #�� �(� e�Q� X(� Make selection .��� /�Y>�� !�� X� 3��  ;� ;% ��$@�� /�Y>�� ��  
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.��$% /�Y>�� N�J��
� B��� C�� )* �*�� 4� .��$% #��I>(� �*� C�� �% �� �����
 +�.��$@�� C�� ���� Pg( �  

c89a38  

  ;>��� �� ;*4 ��G*� �� �� +<�.� �8� ;% 3(� !*� ���� ��1� ;% +FH� B ;>@� �-� ;� N ��� !*� �� +2YO� &�� �� �� ;*4 �� ��$% +-( � �����

.��$% ���� +> �� ;� �� 7� �����>� , ��>��� ;*4 7� 
*��*� �* +(��� ;� ���� �'� ;% ��$% B��0���� ,G� B���� C�� B��� �F>  � �F>  � �F>  B��

4 )* �� �� B�� �� �� �� C�� � ��$% ��G*� �*�1 B ;*4 )* �*�� +��<� �� 3FV. ��.��$@� B���� C�� ;* K��Q� �� �� ;*4 B��0���� �����
 +�

.��$% 3.� �F> .3(� �H� ���V� ;>@� !*�.���� &�G�� �� P@" ��  

��� ���  

 7��% C�� �� P� N�J� �
� �*��% +-ii( ;% B�*�1 ;*4 �� ��� 4� .��ii��� ;>ii��� �� +Lii6� 5P�5� ;% ��$% cYiiO� �� ��� X� X<?4 B4�� ;*

 N�J��
�*� � ��$% +��<� C�� �� N��% ��Q� �� #�$��� ��� �>%���% ��$% +� +-( N�J��
� C�� ;� 3JV� B�
 !��� C�� /�Y>�� �� � ��$% +� ��G

 .���� 
i��� .��i��� 3 �� ;% #��% ����� �� N�J��
� ;*4 �����>��  3FiV. !*� ��  3i(� �>H�    �� +*�H>FiV..��$% #��I>i(� 3Yi( ���� )* ��

 �� ;% �>%���%���� C�� �� ���� ���. 7� #�G$� 7�>( Nm� , N�J��
� �� +>FV. �*�B .��$% +F�  
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.��*�F� B���� C�� N��% W��6 ;� �>%���% X<? ��F
 � K�.� +L�� � �>?��� �L. �� B� ;���� U�� ;% ����� ;>��� 3.� X<?  

��0 ���  

 �� #���� �� 4�� �� ;% ��Q��F� B��� �*�� ;L �� !*� �� B���� C�� 3(� �>H� ;%.��$% +��<� �� �H�� � #��% ��G*� �*�1 ;*4 )* ��1� �� )* ��

5�8� B���  m� ��Q�.��$% ��G*� #��' )* +ii��<� �� �ii6�$" �� )* �� B��� �>H�� �� 7� B��1� B��� �� #�$��� �>%���% B�� ;*4 ��>�� ;% +J�
�
 ;� �

� ;F� � ��$% +� B���� C�� W��I>� B�H���>ii��� ;�� �� �!  ��L%Ctrl  +J�%�
 B�� ��L% 7�� �� � #��% /�Y>��Ctrl + G  #��' )* �� �� �H��

.��$% +� B��0' &�� � #��� ���. &�� �� �� ;��� P@" �� Character .��$�� +�  

  

  

  به نقاشی کردنِ کار کنیم.توضیح خاصی در این قسمت وجود ندارد.باید اجزا و جزییات را ببینیم و با انتخاب رنگ درست شروع 
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�$��1 ���  

;>@�     ;% A�
�
 !*� ;� .���  ;>?�' �8� �� �*�� 3FV . !*� �� B��*� �H� B    5P�5� ��>�� �� , +� �<� �� �6 �$" �� &��% �� 7��% B���� C�� B���

    �H�� A�
�
 ;� � ��$% ��G*� +L6� 5P�5� B�� �� �*�1 B ;*4 )* �*�� W��*�1 �� &��% �� +��<� B��� 4�  �.�*��% B���� C�� �� +L6��  +��<� �

    �*�1 C�� ��% X( � �� � ��O � ��*� �� ;*4 ���-
 3( � !@F�.��$%     3<��Q� +L6 � 5P�5� �� �� 7� +>( ��� �����>� � , ���� 7���� +L6 � 5P�5� �� W�

  !�*�� B ;*4 B� �� �� 7� �*��% ��G*� +Lii6� 5P�5� B�� �� �*�1 ;*4 ;@$*� �� P� Pgii( � ��$% ��G*� �� #��' ��>�� ��@$*� B���.����� � +� ��

  �*�1 B ;*4 B�� �� +$-*.��$% )(�� C$�g�L% �����
  B ;$*�' � #��% 3(�� )�L%Create Clipping Mask   B�� ;*4.��$% +� /�Y>�� ��

    ;*4 B�� �� +�F� � #��  B��0���� � ��G*� ��1 ��Q� &��% �� ;% �$>V � N�J��
� W��*�1 �*� P@" B�� ;*4.��$�J� �� �*� P@"�
� P�5� N�J�

.��� #�� )(�� C$�gL%  

      &�� �� ;% +*�� ;*4 wheels back  � Mirror back               &�� �� �� +*4�� B ;*4 �.�$>iiiV� N�J��
� ;$*� � �� n�� B ;*4 ��$�� +� !�*�� ��

mirror 1  .��$�J� �����
 +� �� 7� �*� P@" �� ;% 3(� o��� 3(�� 3F( ;$*� B ;*4 ��� �� 7� ;% ��$�� +�  
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6�7( ���  

� P� ;% ;*4 !���� ��$% +� +-(��.��$% #��I>(� �*� C�� �% �� . ��$% B���� C�� �� ��� +� /�V_� ��% ;$  

b8aa8d 

  � ;*4 ��G*� �� �-� � #��% B���� C�� �8� ���� C�� �� �� N�J��
� 5P�5� ��>�� NJ. N ��� Nm�.��$% +� +��<� �� P�L� N�J��
� Pg( �� �*�1 B

+� +��<� �� �H�� W��*�1 �H�� 7��% )(�� C$�g�L% � .��$%.��$% 3*�"� �� �H�� ��$% +-( � ��$�J� �� �6�$" #��' A�
�
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65� ���  

�H>FiiV. +iij-� B��� ��   #��I>ii(� )ii(�� �� 3ii(� &�4 W��*�1 +ii��<�

 ��Q�.��$% ��m�      ��'�� B�H����� 7��iiiO% B���    C�� &��$� �� ;% ,

5B����  7���� ,]C��   !>ii��� ;�� �� #��I>ii(� �� �*��� #��� B�� �� ��Iii(

  ��L%Ctrl         �����>�� ��'�� 7��� 7��� C�� B ;*4 B�� �� )�L% �

       .��$% C�� �� �� 7���� +> �� ;�  � ��$% 3@]L]iii( �� 7�    )* ��G*� ��  �

    B��'�L1 , ���� �*�J� ;% +*�1 �� C�� 7�� 
Y� �� �����
 +� )(��

.��$% �� �*� B�� P@".�� ������ ;1�>� �>H� ��$�J�  
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6�8" ���  

  C�� B��� ��Q$�F� � ���� 7�iiO� ��� �� �� ��'�� 7��� ���$ii� 3��  3iiV� ���. ;% +L ��� B��� ��% ������ ��G*� �� )ii(�� �� �� ;*4 �$�

    B��j >� C�� �� �� B�
�*�1 B�� ;*4.�*����� �*�� �� �6 �$" �G  ;% B����     ( �*�2 
 �� B�IV ? �J( )  ;� �����>� ;% ��$% +� cYO � � ��G*�

 .��$% +��<� �� �G  ;% ��$% ���� �� �H�� B�-� N ��� �� 3"�(  
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6�5" ���  

 �1 ;� ��Q$�F� � ;$��� P� 7�F� �* ����' )� B ;*4 #��';*4 ��   �� 7� &�� �G$*� �� ;% �� P�@(� B Outline  �*��� ���. ;�� �� !>���  ��L%

Ctrl  +J�%�
 B����L% B ;L�iii(�� � #��% /�Y>�� ��*�@* �� �� �� ;*4 B��  #��' B ;�<�Ctrl + G  +� � #��� ���. #��' )* �� �� �� #��' &�F


              �� �� ;*4 +L% #��' &��. ��iiiO� ��G*� �H�� �� +
����f
 ;% ��$% NI. �� �� ;*4 ��% !*� �� ������ALL   �Q� � �*��0' +�   �� ;*4 !*� P@" �� K�

*�' B ;L�ii(��  �G��1 �H��� , �*��% B���� C�� 7� �� ;% +*�� ;*4 ;% 3ii(� ��8$� !*� B��� NI. .��$% +� B��0' NI. #�ii� cYiiO� B ;$

�O��.�  
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6�
 ���  

   �� �� B��(  ;���g@* B���� C�� � � #��% /�Y>�� ;��'��1 ��Q� �� �� ;*4 3( � �>H� ;L �� !*� ��B��  �6 �$" B�� W��*�1 ���� &�G��  , B��Q�

    � �H��� 3FiiiV. !*� �� ������ +� ;% B� ;���                   �*�� ;% +$-� !*� ;�.�$iii��� N��-
 �� ��*�@* �� +@*��� +������ �� ;% ������ ���. �� ��$% ��

� �H�� 7�*� �� B�iii2� r�_� �� ;% ��$% /�Y>�� B��: ;L �� !*� �� �� ��1� B��� W��I>� B�H��� �-� ;� �G$*� �� .��$�J� C�� /�Y>�� �� +��@iii�

  �.�*���� ��@� �� 7�����->(� � 3�.`� �*�� , #s��� �� +���� �� �� �>O�� ����� !tFQ�  B��'��@� !*� ;� ���� �*�O�� )*��� ��% B�H>�� ;� ;� �� 
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  ☺شروع بکارگیری خلاقیت و نقاشی کردن  -4
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��6 , &�% , ��� , 
I$�
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مرحله ی مهمی از بکار گیری خلاقیت می شویم  وارد☺ ☺ ☺  
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  هر چه بیشتر جلو می رویم باید حجم دهی بر روی عناصر را بیشتر از هر نکته ای مدنظر قرار دهیم.
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  این آموزش ترجمه ی یکی از آموزش های سایت تاتس پلاس بود
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  روز کاری بوده است. 3مدت زمان گرد آوری و تهیه و تنظیم این آموزش 
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